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OVERVIEW

Move Learners Through the Writing Process
Draft:Builder SOLO Edition steps writers through planning, note-taking, organizing,
citing resources and preparing a rough draft—in every genre and every curriculum
area. Draft:Builder uses a structured framework to break the recursive writing
process down into small, manageable chunks so that learners stay on task.

Practice and Build Process-Writing Skills
Draft:Builder breaks down the writing process, modeling the logical, 
progressive steps of building a good first draft. Each view provides 
considerate scaffolds to help learners transfer information and build on 
ideas as they work through writing's recursive process.

Participate in Grade-Level Curriculum Across 
Content Areas
Content-rich templates support learners as they write in any subject or genre.
General outlines, guiding questions and sentence starters get even the most 
reluctant writers engaged in the writing process. 

Create Differentiated Assignments With Ease
In Teacher Central, educators can quickly customize all multi-sensory supports
to address each writers' individual learning needs. Educators can quickly 
create outline templates at varying levels and assign them to multiple
learners simultaneously. 

About Getting Started 
The Getting Started guide has been designed to assist trainers, educators and
first-time users of Draft:Builder® as if it were being used in an actual educational

setting. The literacy activity uses curriculum-based content and researc h - b a s e d
strategies to demonstrate how the product functions in a meaningful context—first
you participate as a learner, then as a teacher. Further, the step-by-step directions
model a good sequence for learning how to use the product effectively and 
provide best practice and intervention tips. 

This Getting Started Activity does not address every function in the product, but it
does provide all the essentials needed to use Draft:Builder in the classroom after 
completing the activity. In addition to your Getting Started literacy activity, you
may utilize SOLO® Help, an interactive help utility that provides the just-in-time
support you need as you increase your knowledge and proficiency of Draft:Builder. 
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Draft:Builder SOLO Edition
Tutorial 1 Meets Standards

Reading Standards:
• Learners establish a purpose for reading 

(e.g., for information) 

Writing Standards: 
• Learners use prewriting strategies to plan written work

(e.g., use story maps and webs; group related ideas; take
notes; brainstorm ideas; organize information according
to type and purpose of writing)

• Learners use strategies to draft and revise written work
(e.g., reread; add descriptive words and details; delete
extraneous information; elaborate a central idea; use
paragraphs to develop separate ideas; produce a draft)

• Learners use strategies to edit and publish written work
(e.g., edit for spelling at a developmentally appropriate
level; use reference materials; use available technology to
compose and publish work)

• Learners use paragraph form in writing (e.g., arrange 
sentences in sequential order, use supporting and 
follow-up sentences, establish coherence within and
among paragraphs)

• Learners use a variety of strategies to plan research (e.g.,
identify possible topic by brainstorming, use idea webs)

• Learners use strategies to compile information into written
reports or summaries (e.g., incorporate notes into a finished
product; include simple facts, details, explanations 
and examples)

• Learners use appropriate methods to cite and document
reference sources (e.g., bibliography)

Technology Standards:
• Learners know that technology facilitates better 

communication by providing storage and retrieval of
large amounts of data, an easy means of processing 
and displaying data, and faster communication 
among individuals

• Learners use a word processor to copy, move, save and
print text 



Learning Checklist for 
These Tutorials:

❑ Launch Draft:Builder

❑ Sign in as a learner

❑ Open an existing assignment

❑ Preview an assignment

❑ Toggle between Concept and Tree views

❑ Read Locked Text with auditory supports

❑ Modify an Outline

❑ Create notes 

❑ Add text to notes

❑ Add a reference using Bibliographer Wizard

❑ Move notes from the Notes side to Draft side

❑ Read the Draft with auditory supports

❑ Move text in the Draft 

❑ Save assignment

❑ Sign in as a teacher

❑ Create Locked Text

❑ Modify an Assignment Template to create a new one

❑ Save an Assignment Template

❑ Assign work to learners
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Note to Teacher

 Step to Be Followed

Tutorial 1: Use Draft:Builder to Organize Ideas 
Into a Rough Draft

N OTE TO T E AC H E R : In this tutori a l , you are playing the role of  
Learner 1. You will walk through this exercise as if you are a learn e r
using Draft:Builder for the first time. Notes to the teacher are in italics.
Please allow yourself about 25-30 minutes to complete this tutori a l .
After completing this tutorial, you will be able to assist a learner on
the first day with adding, changing and moving information in all
three views of Draft:Builder (Outline, Notes, and Draft) to build a
rough draft.The learner will do the following:

In Outline  
• Open a template

• Work in Map  
• Toggle between Concept and Tree view
• Add, change, delete and move subtopics/text as they brainstorm,

modify and organize their ideas
In Notes  
• Read note instructions tied to subtopic notes
• Create a new note and add text to the new note
• From Notes, move to Draft 
• Add a reference using Bibliographer Wizard 

In Draft 
• Move notes from the Notes side to the Draft side of the screen,

reading Locked Text instructions to guide placement
• Use speech to hear the draft read aloud
• Move text in the Draft view to modify the organization of ideas
• Save the work and export it to a word processing program to

start the editing and revision process







The tutorial is grouped into the following five sections:
1. Launch, Sign In, Open an Existing Assignment  

2. Read Locked Text and Modify an Outline
3. Take Notes and Create a Reference 
4. Organize Notes into a Rough Draft
5. Cut and Paste to a Word Processing Program
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1. Launch, Sign In, Open an Existing Assignment
In this section of the tutorial, you will launch Draft:Builder, sign in
as Learner1 and open an existing assignment called 
My Town Is Best.djs.

A. Launch
 Double-click the SOLO icon on your Windows desktop or

Macintosh dock to launch the program.

B. Sign In
As soon as you start Draft:Builder,  you need to tell
Draft:Builder who you are. For this tutorial, you are 
Learner 1. Sign In appears.

 Select Learner1 in the list. 


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 Click .

 Type the default password, 123456.

 Click to verify your name. Student Central
appears. My Work opens automatically.

Student Central lets you see all of your documents and
assignments. In Student Central you can create a new 
document, open an Assignment Template created by a
teacher or work on an existing assignment. 
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C. Open an Existing Assignment 
The My Work folder contains all the documents you 
create and Assignment Templates created by a teacher and
saved as your work. Find the assignment named My Town
Is Best.djs. 

 Click My Town Is Best.djs to see a preview of the assignment.

A small snapshot of the assignment appears in Preview. The
Preview shows the contents of the selected assignment or
document in the program it was last opened in. 

Look at the Preview to confirm you have the correct 
assignment.

 Double-click My Town is Best.djs in the My Work folder to
open the assignment in Draft:Builder.



The file opens in Outline view. Creating an Outline is the
first step in writing a draft. By showing both panels, you can
quickly see how your assignment is organized. You can 
re-order the subtopics in either the Outline or Map view
and the change also takes place in the other panel.

Look at the right side of Draft:Builder. This is called the
“Map”. The Map is a graphic organizer that shows you how
subtopics in your Outline are connected. Use the Map view
to focus on the overall ideas and organization of your
assignment. When you make a change in your Map, the
change is also made in your Outline.

This is the Tree view in Map.
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You can make the Map view larger by clicking the left side
of the Slide Bar on the toolbar.

2. Read Locked Text and Modify an Outline

A. Read Locked Text
Learner1 has previously worked on this assignment. Learner1
has typed in some reasons why the town is best in the Outline.
Learner1 has also written some notes with some supporting
details for several of the reasons.Today Learner1 has been told
to return to the assignment to add more information to the
Outline and notes and then create a rough draft.

Locked Text is a feature that allows the teacher to write 
instructions to the learner. Only the teacher can create Locked
Text, change it or remove it.The first step the learner needs to
do is to read the Locked Text for any instructions or support
provided by the teacher.

Look at the Outline. Locked Text instructions have been added
to your assignment. Read all of the instructions to get an
o v e rview of the assignment before beginning to write. 

Locked Text appears highlighted. To read the first Locked
Text instructions, place your cursor on the Locked Text

and click. 
The Locked Text becomes highlighted in a different color.



Tip

Slide Bar
Button



To support reading the Locked Text instructions, the learners
may choose to have them read aloud.

 While the Locked Text is highlighted, click Speak on the
toolbar to hear the Locked Text read aloud.  

B. Modify an Outline
Following the instructions the teacher has added to your
assignment, you are now going to modify the Outline.

 Using the scroll bar between the Outline and Map, scroll
down and look at the Outline to see what was written last
time on this topic. 

Think about what else you might add to the Outline.

You see that you only have two reasons listed under best
things to do for fun! You want to add a third reason. 


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 Click reason 3 and type play in snow.

Now you think of a few more fun things to do.

 Click to create a new yellow subtopic under play in
snow. Repeat this step once more to create another 
yellow subtopic.

 Click the first subtopic and type make a snowman.

 Click the next subtopic and type make a snow fort. 
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You see that the last three subtopics are all about playing in
the snow. You decide to better organize these subtopics by
placing the last two entries under play in snow.

 Click make a snowman. 

 Click Indent to change the yellow subtopic to a 
red subtopic.  

Follow these two steps to change make a snow fort to a
red subtopic also.

Advise learners to look at their outlines and think about 
connections between topics and subtopics to better organize
their outlines.

Are there any topics that might fit under two subtopics in
the Outline? Are there any topics that would fit better under
a different subtopic?

 Click the yellow icon next to play at the beach. 

 Click Cut .


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 Scroll up to best location because and click the yellow icon
next to close to the lake. 

 Click Paste . Play at the beach is now a red subtopic of
close to the lake.

 Click the yellow icon next to the yellow subtopic play in snow
and drag it until the yellow line is under the yellow subtopic
close to Chicago. The red subtopics under it will go with it
a u t o m a t i c a l l y. When the yellow line is under c l o s e to Chicago,
stop dragging.

As you create and use your Outline, you might find that you
no longer need or want a subtopic you created. You can
remove the entire subtopic so that your Outline only
includes the information you want for your assignment.

You decide that you do not want the subtopic close 
to Chicago. 

 Click the yellow icon next to close to Chicago and press
Delete on your keyboard. 
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 Delete Topic appears. 

Remember when you delete a topic, you also delete all the
subtopics under it. 

 Click .

3. Take Notes and Create a Reference

A. Take Notes
In Draft:Builder, there are two other views available besides
Outline. They are Notes and Draft.

Now you are ready to change to Notes view to read the
notes you have and add some more notes.

 Click the tab to move from Outline to 
Notes view.



Notice how some of the subtopics have numbers other than
zero after them. The number shows if there is a note already
written for this subtopic and how many notes there are. Notes
may have prompts from your teacher to help you write more.

 Click fire trucks are shiney (misspelling is intentional). Read
the note that has already been written on this topic. Click 
the note and click Speak on the toolbar to hear the note
read aloud.  

You decide to add a new note of your own.

 Find the subtopic Year Round Fun and click it.
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 C lick New Note on the toolbar. An empty Note opens.

 In the Note, type Evanston has year round fun. In the 
summer you can play at the lake. In the winter you can
play in the snow.



 Click .

To familiarize yourself with the toolbar, place your cursor
over each icon on the toolbar to see the name of each 
button and hear it read aloud. Make sure Speak Toolbar
and Dialog Boxes is checked on the Speech menu.

B. Create a Reference
To learn more about your town, you did some research
using an Internet site from the local library. You learned that
ice cream sundaes were invented in your town and you
want to add this information.

 Move down to the green subtopic more reasons… and
click the yellow subtopic invented ice cream sundaes.

 Double-click the note to open the Note.
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You write the following note from information you learned
from your local library's website.

 Type It claims to have invented the sundae. Churchgoers
disapproved of sodas being served on Sundays so the
soda shops started selling ice cream and syrup. The
name was changed to sundae so it wouldn't sound like it
was making fun of the churchgoers.

Keep in mind you may not type more than 300 characters
in a Note. 

When you do research, you need to create a bibliography
that lists all the sources from which you got information.

 Click to enter a reference that can be linked to 
this note. 



Bibliographer opens. The Bibliographer is designed to
help you write a bibliography and check your work as you
go. Examples are given for the basic types of resources.

The reference you want to enter in your bibliography was
found on the Internet, an electronic resource.

 Click from Main Categories.

A new view opens showing an example of a reference for 
an educational cd-rom. 
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Your reference came from the World Wide Web and is in
text form.

 Click world wide web site-text.

Both MLA and APA styles are available. In this tutorial, we are
using MLA.

The Bibliographer provides a wizard that will walk you
through writing your bibliography step-by-step. The Wizard
puts the information you enter into the correct format.

 Click .

The Bibliographer Wizard appears with the entry for the
title of the page. This is the first entry you need to make for
this type of reference.





 Click for additional help. 

 For Title of Page, type History of the Ice Cream Sundae.

 Click . You are asked for the name of the site
or page.

 You do not have a site or page name, so delete the 
highlighted text Title by pressing the delete key.
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 Click . You are asked for the name of the host
or organization that sponsors the website.

 For Name of Host/Organization, type Evanston 
Public Library.

 Click . You are asked for the year of the work.
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 You do not know the year of the work, so delete the 
highlighted text Year by pressing the delete key.

 Click . You are asked for the date that you
looked up the information on the website.

 Type 23 August 2004.

 Click . You are asked for the address or URL of
the website from which you obtained the information.
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 Type Evanston.lib.il.us/community/sundae.html

 Click to return to the Bibliographer.

The Wizard has taken all your entries and put them in the
correct format. Now you need to link the reference to the
note it goes with.

 Click the Notes (invented ic) tab.
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The note you just created appears in the window.

 Click .

The Link cursor appears. 

 Place the Link cursor in the Note you want to attach to a
reference. Click to select the Note.

 Place the Link cursor in the reference you want to attach to
your Note. Click to link your Note and reference. The Link
cursor appears in the Note and in the reference to show
that they are linked.  

 Click to return to the Note.

 Click again to return to Notes view. The 
note that has been linked will have the Link symbol over
the Note icon to show that this Note has been linked to 
a reference. 
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4. Organize Notes into a Rough Draft
You are now going to change from Notes view to Draft
view to organize your notes into a rough draft that you can
use to write and publish your paper.

 Click in the view tabs.

In Draft, read the instructions in Locked Text. 

 Click the note Evanston has year round fun. In the 
summer you can play at the lake. In the winter you can
play in the snow.

30 Getting Started

Draft:Builder SOLO Edition



 Click and drag the note to the Draft window under the
Locked Text Best Location. You are beginning to organize
your notes into paragraphs in draft form.

 Move all your notes to the Draft window and place them
under the appropriate heading. 

When you have finished placing all your notes in your draft,
read and listen to your draft to see if it makes sense. 

 To have all the text read aloud, first highlight all the text by
clicking and dragging the cursor across all the text or by
opening the Edit menu and choosing Select All.

 Then click Speak on the toolbar.

 Stop the speech by clicking Speak again when you hear
something you want to change in your draft. Make changes
to help each sentence in the assignment make sense.

 Click Save to save your work. 

It is always a good idea to save often to avoid losing all
your hard work.
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5. Cut and Paste to a Word Processing Program
If you are a SOLO user, you only need to click the Send to
Write:OutLoud button on the toolbar. Your draft will
open in Write:OutLoud.

Now you have a rough draft that you want to revise and
edit in your word processing program to prepare for 
publishing. You are going to copy your text and paste it 
into your word processing program.

 Highlight all the text in your draft by clicking and dragging
the cursor across all the text or by opening the Edit menu
and choosing Select All.

 Click the Copy button .

 Launch your word processing program and open a 
new document.

 Paste using a key command, tool bar command or the menu
command for P a s t e in your word processing program.

 Save your document and continue to edit your draft into a
finished assignment.

 Close Draft:Builder. From the File menu, click Quit/Exit.

Tip



You return to Student Central where the saved document
appears under My Work.

 Close Student Central by clicking the Quit button in
the upper right-hand corner. Sign In appears.

 Click to exit the program.

Congratulations! You have just completed an assignment.
When you are ready, try Tutorial 2. 
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Note to Teacher

 Step to Be Followed

Tutorial 2: Use Teacher Central to Modify an 
Assignment Template

This tutorial is written for a teacher. After completing this tutorial,
a teacher can use Teacher Central and Draft:Builder to modify an
existing Assignment Template in order to create a new Assignment
Template. A teacher can use the product supports of Create an
Assignment (from an existing assignment), Locked Text, Add a
Subtopic, Add Text to the Subtopic, Change Text of the Subtopic,
Create a New Level of Subtopic, Create a New Note Instruction in
Locked Text for a Subtopic, Change Locked Text in Existing Note
Prompts, Save the New Assignment Template and Assign It. Please
allow 30-35 minutes to complete this tutorial.

1. Launch, Sign In to Teacher Central, Open an Assignment Template

2. Modify an Assignment Template

3. Save as a New Assignment Template

4. Assign to Learners




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1. Launch, Sign In to Teacher Central, Open an
Assignment Template
In this section of the tutorial, you will launch Draft:Builder, sign in 
as Teacher and open an Assignment Template called Treasure
Island Character Study.asn.You have a current Assignment Template
on Long John Silver that you want to modify for learners who need 
more structure.

A. Launch

 Double-click the SOLO icon on your Windows desktop 

or Macintosh dock to launch the program.

B. Sign In to Teacher Central
Sign In appears.
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 Click . Teacher Sign In appears. 

 Click the pull down menu and select Teacher.

 Type in your Password: school

 Click .

Teacher Central appears. Teacher Central lets a teacher 
perform administrative tasks needed to create Assignment
Templates and manage learners' work.



C. Open an Assignment Template
An Assignment Template is an assignment created by a
teacher. Only a teacher can create or modify an Assignment
Template. Once created, a teacher may assign the template
to one or more learners. In this tutorial, you are going to
create a new Assignment Template by modifying an 
existing one. 

 Click . Create New Assignment a p p e a r s .

 Click . The dialog Create an assignment based
on a saved assignment appears.

 Select Treasure Island C... and click .
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The Assignment Template Treasure Island Character.asn
opens in Draft:Builder.

2. Modify an Assignment Template
You are going to modify an existing Assignment Template and add
more scaffolding in the form of instructions by each subtopic to help
guide learners as they write their notes.

 Click the green icon next to Characteristics.

 Click Insert Locked Text on the toolbar. A text box
appears above the subtopic Characteristics.
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 In the text box, type: Type three characteristics of Long
John Silver.

You have now added Locked Text instructions that can help
guide the learners. These instructions are “locked” so that
the learners cannot change them. 

Now you are going to add more specific structure to the
Outline to help the learners. 

 Click the green icon next to Characteristics and click 
on the toolbar. A new subtopic is created.

 Click the Indent button . The green subtopic changes to
a yellow subtopic.
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 Type Physical Attributes.

 On the toolbr, click to create a second yellow subtopic.
Type Personality.

 On the toolbr, click to create a third yellow subtopic.
Type Actions.

Now add Locked Text to provide instructions to the learners.

 Click Insert Locked Text three times to add three 
text boxes above Characteristics. 
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 In the first box, type What does he look like? Put your
notes under Physical Attributes. and press Enter.

 Click the second text box to open it and type Is the 
character friendly, funny, happy, mean, scary, angry or
another descriptive word? Put your notes under
Personality. Press Enter.

 Click the third text box to open it and type What kinds of
things does the character do? Put your notes under
Actions. Press Enter.
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To make the assignment easier, you are going to delete the
rest of the subtopics. Having only one concept
“Characteristics” for this assignment will reduce the 
complexity of the assignment for the learners.

 Click the green icon next to Good or bad character?

 Press Delete on your keyboard. Delete Topic appears.

Remember when you delete a topic, you also delete all the
subtopics (children) under it. 

 Click .

At the end of the story he…. is now selected.

 Press Delete on your keyboard. Delete Topic appears.
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 Click .

3. Save as a New Assignment Template
Now that you have finished modifying this Assignment Template,
you need to save it with a new name.

 From the File menu, click Save as…
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Template Description appears.

 Type Long John Silver's characteristics - physical, 
personality, actions.

 Click . Save Assignment As… appears.

 After File name, type Long John Silver's Characteristics in DB.
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4. Assign to Learners
Now you are going to assign the new Assignment Template. 

 Click . Assign appears.

 To assign this Assignment Template to Learner1, place a
check in the checkbox next to Learner 1.
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 Click . You return to Save Assignment As….

 Click . You return to the Draft:Builder Outline.

 Close Draft:Builder by opening the File Menu and clicking
Quit/Exit.
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You return to Teacher Central.

 Close Teacher Central by clicking the Quit button in
the upper right-hand corner.

Sign In appears. 

 Click to exit the program.

C o n gratulations! You have just created your first Assignment
Template. It would be a good idea to walk through the
Assignment Template you have created as a learner in ord e r
to make sure that it functions corre c t ly.
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• _A Blank Template.opt
• A 3 Paragraph Essay.opt
• A 5 Paragraph Essay.opt
• Beginning Middle End.opt
• Biography DraftBuilder.opt
• Book Report Fiction.opt
• Compare Charac

DraftBuilder.opt
• Compare Contrast General.opt

• Descriptive Paragraph.opt
• KWRL DraftBuilder.opt
• Persuasive Essay 1.opt
• Persuasive Essay 2.opt
• Plan a Story.opt
• SQ3R DraftBuilder.opt
• Story Map DraftBuilder.opt
• Vocabulary 1 DraftBuilder.opt

Generic Assignment Templates
Generic Assignment Templates are content-free, research-based
assignment templates for use with any eText or modified for your
learner and/or area of curriculum.

• Compare Contrast
Characters.asn

• Interview a Friend.asn

• KWRL.asn
• Story Map.asn
• Supported Reading SQ3R.asn

APPENDIX 1: Supporting Files

Assignment Te m p l ates and Outline Te m p l at e s
I n cluded with Dra f t : B u i l d e r, S O LO Edition 

Included with your Draft:Builder, SOLO Edition product are
Assignment Templates and Outline Templates. 

Outline Templates
Outline Templates are content-free, research-based templates that can
be used “as is” or modified to meet specific learner and/or curriculum
needs. Use Outline Templates to guide learners through the writing
process in Draft:Builder.



Sample Assignment Templates Sample Curriculum Folder

Long John DraftBuilder.asn Literature

Saturn DraftBuilder.asn Science

Ancient Egypt DraftBuilder.asn History

Rainforest DraftBuilder.asn Geography

Sample Curriculum Folders and 
Sample Assignment Templates
There are four sample Curriculum Folders and Sample Assignment
Templates. In each Curriculum Folder, you will find:

• 1 assignment to organize and draft ideas using Draft:Builder

Listed here are the file names.

Draft:Builder SOLO Edition
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Limited Warranty

Don Johnston Incorporated warrants software for one year from date of purchase. 
This warranty is valid against manufacture defects and malfunctions not the result of 
abuse or mishandling. Except for the above, Don Johnston makes no warranties, 
express or implied, including warranties as to the merchantability or as to the fitness 
of this product for any particular purpose, and shall not be liable for any loss or 
damage, directly or indirectly, arising from the use of this software product or for 
consequential damages. 

Don Johnston Incorporated reserves the right to make any changes, additions or 
improvements to software or documentation at any time without notice to any 
person or organization.

The manuals and the software described in them are copyrighted, with all rights 
r e s e rved. Under the copyright laws, the manuals or the software may not be copied, 
in whole or in part, without written consent of Don Johnston, except in the normal 
use of the software. The same proprietary and copyright notices must be affixed to 
any permitted copies as were affixed to the original. This exception does not allow 
extra copies to be made for others, whether or not sold, but all the material 
p u rchased (with all backup copies) may be sold, given, or loaned to another person. 
Under the law, copying includes translating into another language or format. 
You may use the software on any computer owned by you, but extra copies cannot 
be made for this purpose.

DON JOHNSTON INCORPORATED MAKES NO WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE SOFTWARE. DON JOHNSTON'S
LICENSOR(S) DOES NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS
REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS
CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. THE ENTIRE RISK 
AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. 
THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME JURISDICTIONS.
THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL DON JOHNSTON'S LICENSOR(S) AND THEIR DIRECTORS, 
OFFICERS, EMPLOYEES OR AGENTS (COLLECTIVELY DON JOHNSTON'S LICENSOR) 
BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR 
INABILITY TO USE THE SOFTWARE EVEN IF DON JOHNSTON'S LICENSOR HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL 
OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 
Don Johnston's Licensor's liability to you for actual damages from any cause whatsoever,
and regardless of the form of the action (whether in contract, tort (including negligence),
product liability or otherwise), will be limited to $50.



One Completely 
Integrated Solution

Combine Draft:Builder with our industry-standard reading and 
writing interventions to address the entire learning continuum across
the curriculum. Complete the SOLO learning environment and
increase the considerate supports available: 

When used with SOLO's Text Reader, Draft:Builder 
imports the outline created during reading to support the
draft-writing process.

When used with SOLO's Word Prediction and Vocabulary
Development Assistant, just-in-time support for content-
area and topic-specific words is available by applying Topic
and Genre Dictionaries. An eWord Bank displays a list of
words to tap prior knowledge about the writing topic.

When used with SOLO's Talking Word Processor,
Draft:Builder's content exports directly into the talking word
processor and reflects all of the outlining, note-taking and
drafting completed with Draft:Builder. This provides a 
seamless transition into the next steps of the writing
process—revision, editing and publishing.

For more information about Don Johnston's revolutionary
learning intervention—SOLO™—visit donjohnston.com or contact

Customer Success at 800.999.4660

X5328  900A


